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Preface
The SAP Automation pack files are a collection of Cisco Process Orchestrator (CPO) processes
(workflows) authored by subject matter experts that work out-of-the-box to automate best practices for
a particular technology. The automation pack files also include configuration objects that are used in the
processes, such as variables, categories, target groups and knowledge base articles.
The SAP Automation Pack for SAP Solution Manager E2E Response contains the content used to
automate analysis and problem resolution for incidents triggered by SAP Solution Manager alerts.
This guide is intended to provide information on importing and using the SAP Solution Manager E2E
Response automation pack in Process Orchestrator.

Organization
This guide includes the following sections:
Chapter 1

Importing Automation Packs

Provides instructions for installing the automation
pack during or after the initial installation of Cisco
Process Orchestrator.

Chapter 2

Understanding the Automation
Pack Content

Provides information on the content included in
the automation pack.

Chapter 3

Getting Started Using the
Automation Pack

Provides information on configuring the objects in
Cisco Process Orchestrator that are referenced by
the content in the automation pack—runtime users,
targets, task rules, target properties, and global
variables.

Chapter 4

Managing SAP Solution Manager Provides information on using and managing the
E2E Response Processes
SAP Solution Manager processes.

Appendix A

Understanding the Core
Automation for SAP Content

Provides information on the content included in
the Core Automation for SAP automation pack.
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Conventions
This guide uses the following conventions:
Convention

Indication

bold font

Commands and keywords and user-entered text appear in bold font.

italic font

Document titles, new or emphasized terms, and arguments for which you supply
values are in italic font.

[ ]

Elements in square brackets are optional.

{x | y | z }

Required alternative keywords are grouped in braces and separated by
vertical bars.

[x|y|z]

Optional alternative keywords are grouped in brackets and separated by
vertical bars.

string

A nonquoted set of characters. Do not use quotation marks around the string or
the string will include the quotation marks.

courier

font

Terminal sessions and information the system displays appear in courier font.

< >

Nonprinting characters such as passwords are in angle brackets.

[ ]

Default responses to system prompts are in square brackets.

!, #

An exclamation point (!) or a pound sign (#) at the beginning of a line of code
indicates a comment line.

Note

Means reader take note.

Tip

Means the following information will help you solve a problem.

Caution

Timesaver

Warning

Means reader be careful. In this situation, you might perform an action that could result in equipment
damage or loss of data.

Means the described action saves time. You can save time by performing the action described in
the paragraph.

Means reader be warned. In this situation, you might perform an action that could result in
bodily injury.
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Product Documentation
Documentation Formats
Documentation is provided in the following electronic formats:
•

Adobe® Acrobat® PDF files

•

Online help

You must have Adobe® Reader® installed to read the PDF files. Adobe Reader installation programs for
common operating systems are available for free download from the Adobe Web site at www.adobe.com.

Guides and Release Notes
You can download the Cisco Process Orchestrator product documentation from Cisco.com. Release
Notes can be found on Cisco.com and the product CD.

Online Help
Online help is available and can be accessed using the following methods:
•

Click the Help button on any dialog in the application to open the help topic in a pane to the right
of the dialog.

•

In the Process Orchestrator console:
– Click the Help Pane

tool on the toolbar to open the help topic in a pane to the right of the

console results pane.
– Click Help on the menu bar.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional
information, subscribe to the What’s New in Cisco Product Documentation as a RSS feed and set content
to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco
currently supports RSS Version 2.0.
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CH A P T E R

1

Importing Automation Packs
After installing Cisco Process Orchestrator, you can choose to continue to importing the automation
packs, or import them later from within the Console. This chapter guides you through importing the
Cisco Process Orchestrator Automation Pack for SAP Solution Manager E2E Response automation
pack. It includes the following sections:

Note

•

Accessing the Automation Pack Import Wizard, page 1-2

•

Importing the Core Automation for SAP.tap, page 1-3

•

Importing the SAP Solution Manager E2E Response.tap, page 1-4

•

SAP Solution Manager Adapter Requirements, page 1-4

•

Configuring SAP Solution Manager Templates, page 1-5

•

Creating and Scheduling Alert Queue Cleanup Jobs, page 1-6

It is recommended that you review the system requirements and prerequisites before importing
automation packs. See the Intelligent Automation for SAP 3.0 Installation Guide.

Process Automation Guide for SAP Solution Manager E2E Response
OL-30858-01

1-1

Chapter 1
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Accessing the Automation Pack Import Wizard

Accessing the Automation Pack Import Wizard
You use the Automation Pack Import Wizard to import the automation packs (tap files). You can open
the wizard immediately after installing Process Orchestrator or from within the Console.

Opening the Import Wizard After Running Setup Wizard
Step 1

After running the Setup wizard to install the product, ensure that the Launch automation pack import
wizard now check box is checked before closing the wizard.

Step 2

On the Select Automation Packs dialog box, check the following check boxes and then click OK to
launch the Automation Pack Import Wizard:
•

Core Automation for SAP

•

SAP Solution Manager E2E Response

Note

See the Cisco Process Orchestrator Installation Guide for instructions on importing and
configuring the Core components for the product.

Proceed to Importing the Core Automation for SAP.tap, page 1-3.

Opening the Import Wizard from Console
You can open the Automation Pack Import Wizard from within the Console after installing the product.
When importing automation packs from within the Console, you must re-open the Automation Pack
Import Wizard for each automation pack that you are importing.
Because the SAP Solution Manager E2E Response automation pack has a dependency on the Core
Automation for SAP automation pack, you must import the Core Automation for SAP automation pack
first.
Step 1

In the Administration workspace on the Console, click Automation Packs in the navigation pane.

Step 2

Use one of the following methods to open the Automation Pack Import Wizard:

Step 3

•

In the navigation pane, right-click Automation Packs and choose Import.

•

On the Menu bar, choose Actions > Import.

On the Windows Open dialog box, select the Core Automation for SAP.tap file and click Open to
launch the Automation Pack Import Wizard.
Proceed to Importing the Core Automation for SAP.tap.

Process Automation Guide for SAP Solution Manager E2E Response

1-2

OL-30858-01

Chapter 1

Importing Automation Packs
Importing the Core Automation for SAP.tap

Importing the Core Automation for SAP.tap
You must first import the Core Automation for SAP automation pack (Core Automation for SAP.tap). If
you opened the Automation Pack Import Wizard from the Setup Completed panel, the wizard will guide
you through importing each automation pack.
Step 1

On the Automation Pack Import Wizard Welcome panel, click Next.

Note

If you do not want to display the Welcome panel the next time the wizard is opened, check the
Do not show this page next time check box.

Step 2

On the General Information panel, review the information about the automation pack.

Step 3

If you want to disable all the processes that are imported with the automation pack, check the Disable
all imported processes check box.

Note

Step 4

If you disable all the imported processes, you will need to manually enable the processes in the
Console before they can execute.

Click Next to continue.
Use the Default Incidents Assignee Setup panel to specify the default person who should be assigned
SAP-related incidents.

Step 5

Click the Browse

button to specify the user.

Step 6

On the Select User or Group dialog box, click Location and choose the location from which the user
will be selected.

Step 7

In the text box, enter the user name and click Check Names.
If the name is found, the box will be populated with the appropriate email address.

Step 8

Click OK to close the Select User or Group dialog box.

Step 9

On the Default Incidents Assignee Setup panel, click Next.
The Review Prerequisites panel displays the prerequisites for the automation pack being imported. The
green check mark indicates that the prerequisite was found on the computer.
The red X indicates that the prerequisite was not found on the computer. When this occurs, the import
process is stopped and cannot continue until all prerequisites have been met.
If all prerequisites are passed, the wizard automatically continues to the next panel.

Note

Step 10

If you opened the Automation Pack Import Wizard from the Setup Completed panel, the wizard
displays the General Information panel for the next automation pack.

After the objects have been imported, review the information on the Completing the Automation Pack
Import Wizard panel to verify that it is correct and then click Close to close the wizard.

Process Automation Guide for SAP Solution Manager E2E Response
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Importing the SAP Solution Manager E2E Response.tap

Importing the SAP Solution Manager E2E Response.tap
If you are importing the automation packs from within the Console, you must re-open the Automation
Pack Import Wizard to import the SAP Solution Manager E2E Response automation pack.
Step 1

Use one of the following methods to open the Import Automation Pack Wizard:
•

In the navigation pane, right-click Automation Packs and choose Import.

•

On the Menu bar, choose Actions > Import.

Step 2

On the Windows Open dialog box, select the SAP Solution Manager E2E Response.tap file and click
Open to launch the Automation Pack Import Wizard.

Step 3

On the Welcome panel, click Next.

Step 4

On the General Information panel, review the information about the automation pack.

Step 5

If you want to disable all the processes that are imported with the automation pack, check the Disable
all imported processes check box.

Note

Step 6

If you disable all the imported processes, you will need to manually enable the processes in the
Console before they can execute.

Click Next to continue.
The Data Extraction panel is used to specify the destination where the ABAP Transport files will be
extracted. The ABAP Transport files must be installed on the SAP Solution Manager systems on which
some remote function calls that are used in this automation pack will be executed.

Note
Step 7

If you uncheck the ABAP Transport check box, the files will not be extracted.

Accept the default location or click the Browse
and then click Next.

tool to specify a different location to extract the files

If all prerequisites are passed, the wizard automatically continues to the next panel.
Step 8

After the objects have been imported, review the information on the Completing the Automation Pack
Import Wizard panel to verify that it is correct and then click Close to close the wizard.

SAP Solution Manager Adapter Requirements
This section describes the requirements that must be met for SAP Solution Manager Adapter
functionality.

Prerequisites
The SAP Solution Manager Adapter requires the following prerequisites:
•

SAP .NET Connector 3.0 for .NET 4.0 on x64 version 3.0.7.0 or higher. The following dll files must
be copied to the Process Orchestrator server:

Process Automation Guide for SAP Solution Manager E2E Response
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Importing Automation Packs
Configuring SAP Solution Manager Templates

– sapnco.dll
– sapnco_utils.dll

Before you can configure an SAP Solution Manager target, these files must be installed on the
Process Orchestrator server. See the Cisco Process Orchestrator Online Help for instructions on
installing these files.
•

SAP Solution Manager 7.1 SP05 or later
– The SAP Solution Manager 7.1 system and basic setup must be completed.
– Managed Objects must be configured.

•

SAP ABAP/Netweaver 7.02 SP10

SAP Solution Manager Add-On
The SAP Solution Manager Adapter core functionality in Process Orchestrator is provided by the Cisco
Add-On. The SAP Solution Manager Adapter requires the Cisco Add-On file to be installed on SAP
Solution Manager.

Importing the Cisco Add-On On SAP Solution Manager
Perform the following procedure to import the Cisco Add-On file into the SAP Solution Manager system
using the SAP transaction SAINT.
Step 1

Navigate to the location where the ABAP Transport data was extracted for the SAP version of the
systems in your environment. The default location is:
C:\Users\[username]\Documents\Cisco\Cisco Process Orchestrator\Extracted Data\ABAP
Transports\Solution Manager\Add-on\7.1

Step 2

Copy the SAP Add-On Package file(s) to the following location on the SAP server:
usr\sap\trans\EPS\in

Step 3

Log onto client 000 of the SAP system using an administrator account (DDIC or SAP* are not valid
accounts) and run the SAP transaction code SAINT.

Step 4

Follow the standard SAP procedures for performing an add-on product installation using SAINT.

Note

To verify whether the add-on is on the SAP system, use the SAP menu path System > Status and review
the software component versions for the Cisco software component add-on/CISCOSM/.

Configuring SAP Solution Manager Templates
The SAP Solution Manager Template Settings must be configured to set the Third-Party Connector to
use SAP IT Process Automation by Cisco for all alerts to be passed to Process Orchestrator for
processing. The SAP Solution Manager E2E Response automation pack provides a transport that
contains templates that have already been configured with the third party connector set for SAP IT
Process Automation by Cisco.

Process Automation Guide for SAP Solution Manager E2E Response
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Creating and Scheduling Alert Queue Cleanup Jobs

Alternatively, if you are using custom templates in your environment, you must manually set the
third-party connector to SAP IT Process Automation by Cisco so that alerts will be forwarded to Process
Orchestrator for processing.

Configure Custom Templates
If you are using custom templates in SAP Solution Manager, the third-party connector must be set to
SAP IT Process Automation by Cisco.
Step 1

In Configuration Explorer, navigate to the template and select it.

Step 2

On the Template Settings tab, click Expert Mode.

Step 3

Select the Third-Party Components tab and set the third-party connector to SAP IT Process Automation
by Cisco.

Step 4

Save the template.

Step 5

Re-activate the template assignment to monitored objects (Technical Monitoring, Step 6).

Creating and Scheduling Alert Queue Cleanup Jobs
It is recommended that you create a job in SAP Solution Manager to perform daily cleanup of the event
queue table to remove alerts that have exceeded the specified threshold. Perform the following procedure
to create and schedule the job.

Create Variant
The first step in creating a job is to run SAP transaction SE38 – Create Variant.
Step 1

Log into the SAP system and run SAP transaction SE38 or navigate to the ABAP Editor (click Tools >
ABAP Workbench > Development > ABAP Editor).

Step 2

In the Program text field, enter /CISCOSM/TEO_CLEAR_ALERT_QUEUE.

Step 3

Click the Variants radio button and then click Change.

Step 4

Specify the following information to specify which alerts to be cleared from the queue:

Step 5

•

Age of oldest record in days—Number of days after which alerts will automatically be deleted.

•

Maximum queue entries—Number of queue entries to maintain before deleting entries.

Enter a name for the variant and then click Save.

Note

The suggested name is ALERTQ_STD for standard parameters.

Process Automation Guide for SAP Solution Manager E2E Response

1-6

OL-30858-01

Chapter 1

Importing Automation Packs
Creating and Scheduling Alert Queue Cleanup Jobs

Create Daily Job
The next step is to create a background job to clear the queue daily. You must schedule a daily job with
the following (recommended) job name:
/CISCOSM/CLEAR_ALERT_QUEUE_DLY
If you use a different job name, update the SAP Solution Manager Target properties (Solution Manager
tab) with the updated job name. Otherwise, an alert is displayed in the Cisco Process Orchestrator.
Step 1

Run SAP transaction SE36 – Define Background Job.

Step 2

Enter a name for the background job in the Job Name field.

Step 3

Click Step on the menu bar to create the job step.

Step 4

Enter the information for the job step.

Step 5

Click Start Condition on the menu bar to specify the interval at which jobs should be run.

Step 6

In the Job start area, specify the Date and Time the job should begin running.

Step 7

In the Job frequency area, specify how often the job should run (Daily).

Step 8

Click Save to save the job.

Process Automation Guide for SAP Solution Manager E2E Response
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Creating and Scheduling Alert Queue Cleanup Jobs

Viewing Deleted Alerts
You can view a summary of the alerts that have been deleted from the alert queue using SAP transaction
SLG1 (Application Log).
Step 1

Run SAP transaction SLG1 (Application Log).

Step 2

Enter the following information:

Step 3

•

Object name—/CISCOSM/LOG

•

Subobject—ALERTQ.

Click Execute to review the messages. Messages indicate how many queued entries are removed.

Process Automation Guide for SAP Solution Manager E2E Response

1-8

OL-30858-01

CH A P T E R

2

Understanding the Automation Pack Content
The SAP Solution Manager E2E Response automation pack includes the content used to automate best
practices for identifying and analyzing performance problems within your SAP Solution Manager
environment, and initiating corrective actions to resolve Solution Manager alerts.
This chapter provides information about the content included in the SAP Solution Manager E2E
Response automation pack. It contains the following sections:

Note

•

Accessing Automation Pack Properties, page 2-2

•

Viewing Automation Pack Content and Dependencies, page 2-3

See Appendix A, “Understanding the Core Automation for SAP Content” for information on the content
included in the Core Automation for SAP automation pack.
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Accessing Automation Pack Properties

Accessing Automation Pack Properties
Users can access the automation pack properties from the Administration—Automation Packs view in
the console. The automation pack properties dialog box displays general information about the
automation pack, version number, publish date, list of content (objects), the dependencies of the
automation pack, and the history of changes made to the automation pack.
Step 1

On the Administration workspace, click Automation Packs in the navigation pane to display the
installed automation packs in the Automation Packs pane.
Information about the automation packs display in the following columns:
Column

Description

Company Name

Name of the company that released the automation
pack.

Publish Date

Date the automation pack was created or exported to a
file.

Version

Version number of the automation pack.

Display Name

Name of the automation pack.

ID

Identification number of the automation pack.

Import Date

Date the automation pack was imported into the
product.

Licensed

Indicates whether the automation is a licensed product
in Process Orchestrator.

Description

Text description of the automation pack.

Step 2

Select the automation pack in the Automation Packs pane, right-click and choose Properties.

Step 3

On the Properties dialog box, click the appropriate tab to view the automation pack properties:

Step 4

Tab

Description

General

Displays general information about the automation pack.

Objects

Display a list of the content included in the automation
pack.

Dependencies

Display a list of automation packs and adapters referenced
by the objects in the automation pack.

History

Displays when the automation pack was created or
modified, and audit log entries that are relevant to the
automation pack.

When you have completed viewing the automation pack properties, click Close to close the dialog box.
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Viewing Automation Pack Content and Dependencies
Use the automation pack Properties dialog box to view the content (objects) included in the automation
packs and the dependencies associated with the automation pack.

Viewing Automation Pack Content
Use the Objects tab to view a list of the content provided by the automation pack.
Step 1

On the Administration—Automation Packs view, select SAP Solution Manager E2E Response,
right-click and choose Properties.

Step 2

On the SAP Solution Manager E2E Response Properties dialog box, click the Objects tab.

Step 3

On the Objects tab, review the information about the content included in the SAP Solution Manager E2E
Response automation pack.
Columns

Description

Display Name

Name of the object (processes, global variables,
knowledge base).

Type

Object type.

Action Required

Action required to successfully import or export the
objects.

Customization Setting

Displays the customization setting for the automation
pack:
•

No—Indicates the author of the object prefers the
object to remain unchanged whenever a new
automation pack is imported.

•

Limited—Indicates the author has granted editing
permission to some properties of the object and any
changes made will be preserved whenever a new
automation pack is imported.

•

Workflow—Indicates the author has granted
editing permission to the process properties and the
objects within the process workflow.

Description

Text description of the object.

Version

Object version.

Process Automation Guide for SAP Solution Manager E2E Response
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SAP Solution Manager E2E Response Processes
The following table contains the processes that are imported by the SAP Solution Manager E2E
Response automation pack.
Process Name

Description

Background Work Process Analysis

Returns a table with the number of background work
processes per application server and number of used
background work processes per application server.

Dialog Work Process Analysis

Returns a table with the number of dialog work processes
per application server and number of used dialog work
processes per application server.

Not Enough Update Resources

Raises an incident when a Solution Manager Not Enough
Update Resources alert is created.

SM – ABAP Instance Not Available

Raises an incident when a Solution Manager ABAP
Instance not available alert is created.

SM – Bad Dialog Response Time

Detects and analyzes the cause of slow dialog response
time.

SM – Errors in ABAP System Log

Raises an incident when a Solution Manager Errors in
ABAP System Log alert is created

SM – Errors in Java Logs Detected

Raises an incident when a Solution Manager Errors in Java
Logs Detected alert is created.

SM – Get Server Name

Parses the server name from a Solution Manager alert.

SM – High CPU Utilization

Raises an incident when a Solution Manager High CPU
Utilization alert is created.

SM – High Number of ABAP Short
Dumps

Raises an incident when a Solution Manager High Number
of ABAP Short Dumps alert is created.

SM – High number of ABAP System Log Raises an incident when a Solution Manager High Number
Messages
of ABAP System Log Messages alert is created.
SM – High Update Response Time

Raises an incident when a Solution Manager High Update
Response Time alert is created.

SM – High User Load on ABAP System

Raises an incident when a Solution Manager High User
Load on ABAP System alert is created.

SM – Locked Users

Raises an incident when a Solution Manager Locked Users
alert is created.

SM – Metrics Collection

Retrieves metrics information from Solution Manager
alerts.

SM – Not Enough Batch Resources

Raises an incident when a Solution Manager Not Enough
Batch Resources alert is created.

SM – Not Enough Dialog Resources

Raises an incident when a Solution Manager Not Enough
Dialog Resources alert is created.

SM – Not Enough Spool Resources

Raises an incident when a Solution Manager Not Enough
Spool Resources alert is created.

SM – Oracle Tablespace Free Space

Raises an incident when a Solution Manager Oracle
Tablespace Free Space alert is created.
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Process Name

Description

SM – qRFC Errors

Raises an incident when a Solution Manager qRFC Errors
alert is created.

SM – Resolve Locked Users

Triggered by an Resolve Locked Users incident. It attempts
to resolve the incident by unlocking the account.

SM – Resolve Not Enough Batch
Resources

Triggered by a Not Enough Batch Resources incident. It
attempts to resolve the incident by changing the operations
mode based on user selection.

SM – Resolve Server Unavailable

Triggered by a SAP server unavailable incident. It attempts
to resolve the incident by starting the application server.

SM – tRFC Entries in Status CPICERR

Raises an incident when a Solution Manager – tRFC
Entries in Status CPICERR alert is created.

SM – tRFC Entries in Status SYSFAIL

Raises an incident when a Solution Manager – tRFC
Entries in Status SYSFAIL alert is created.

Spool Work Process Analysis

Returns a table with the number of spool work processes
per application server and number of used spool work
processes per application server.

Update Work Process Analysis

Returns a table with the number of update work processes
per application server and number of used update work
processes per application server.

SAP Solution Manager E2E Response Target Properties
The following table contains the target properties that are imported by the SAP Solution Manager E2E
Response automation pack. The target properties that do not have a value defined must be configured by
the user prior to using them in processes.

Note

Target Properties

Description

Value
Defined?

Solution Manager: Monitored
System Log Message Numbers

Enter the system log number and the incident name.

Yes

For information on configuring target properties, see Managing Target Properties, page 3-24.

SAP Solution Manager E2E Response Target Groups
The following target group is imported by the SAP Solution Manager E2E Response automation pack.
Target Group Name

Description

All SAP Solution Managers

Includes all SAP Solution Manager targets.
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Viewing Automation Pack Dependencies
Use the Dependencies tab to view the automation packs and adapters referenced by the objects in the
automation pack. These object must be installed prior to importing the SAP Solution Manager E2E
Response automation pack.
Step 1

On the Administration—Automation Packs view, select SAP Solution Manager E2E Response,
right-click and choose Properties.

Step 2

On the SAP Solution Manager E2E Response Properties dialog box, click the Dependencies tab.

Step 3

Review the list of automation packs and adapters referenced by the SAP Solution Manager E2E
Response automation pack:
Object Type

Dependency

Automation Packs
Adapters

Step 4

•

Core Automation for SAP

•

Incident Response for SAP

•

Core Functions Adapter

•

IBM DB2 Database Adapter

•

Microsoft SQL Server Database Adapter

•

Microsoft Windows Adapter

•

Oracle Database Adapter

•

SAP ABAP Adapter

•

SAP Solution Manager Adapter

•

Terminal Adapter

Click Close to close the dialog box.
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Getting Started Using the Automation Pack
Before you begin using the content that ships with the automation pack, you must create the objects in
Process Orchestrator that are referenced in the processes. These objects include targets, runtime users,
task rules for assignments and notifications, and target properties.
This chapter provides basic information on defining the objects. It includes the following sections:
•

Creating an SAP User Account, page 3-2

•

Creating SAP Solution Manager Targets, page 3-2

•

Managing SAP Solution Manager Targets, page 3-6

•

Using Task Rules for Assignments and Notifications, page 3-14

•

Managing Target Properties, page 3-24

•

Managing Global Variables, page 3-26

For additional information about the objects discussed in this chapter, refer to the following
documentation:
Document

Description

Process Orchestrator User Guide

General information about Core product features.

Cisco Process Orchestrator Online Help

Information about the objects specific to SAP Solution
Manager Adapter (runtime user, target, and activities).

Intelligent Automation for SAP 3.0
Installation Guide

Information about configuring and managing the objects in
Process Orchestrator specific to SAP Solution Manager.
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Creating an SAP User Account
The SAP User runtime user account is used to connect to the SAP Solution Manager target on which the
processes will execute. You can create the SAP User account prior to creating the target or when you
create the SAP Solution Manager target and specify the runtime user account.
This section guides you through creating the SAP User account prior to creating the SAP Solution
Manager target.
Step 1

In the Definitions workspace, right-click Runtime Users and choose New > SAP User to open the New
SAP User Properties dialog box.

Step 2

On the General tab, specify the following information:

Note

The Required Value
icon displayed on a tab or page indicates that the field is required and
is either missing a value or contains an invalid value.

Field

Description

Display name

Name for the user account that displays in the Console.

User name

User name assigned to the SAP user account that
connects to the SAP application server.

Password

Password assigned to the SAP user account that
connects to the SAP application server.

Client

SAP client number assigned to the user account.

Description

Information that describes the user account.

Note

The Used By tab displays objects used by the runtime user and will remain blank until used by
an object.
The History tab displays the history of actions taken against the runtime user and will remain
blank until after the initial creation.

Step 3

Note

Click OK to close the dialog box.

For additional information on creating and managing runtime users, see the Process Orchestrator User
Guide.

Creating SAP Solution Manager Targets
Before you can create or run processes in your SAP Solution Manager environment, you must create the
targets on which the processes will run. You use the New SAP Solution Manager wizard to create SAP
Solution Manager targets.
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Note

The SAP Solution Manager Adapter requires the dll files for SAP .NET Connector 3.0 for .NET 4.0 on
x64 version 3.0.7.0 or higher. Before you can configure an SAP Solution Manager target, these files must
be installed on the Process Orchestrator server.
See the Intelligent Automation for SAP 3.0 Installation Guide for instructions on installing the required
files.

Note

Prior to creating an SAP Solution Manager target, you must have at least one SAP system that is
monitored by Solution Manager. For instructions on creating SAP systems targets, see the Intelligent
Automation for SAP 3.0 Installation Guide.
This section guides you through creating an SAP Solution Manager target.

Step 1

On the Definitions workspace, right-click Targets and choose New > SAP Solution Manager to open
the New SAP Solution Manager wizard.

Step 2

Click Next.
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The Required Value
icon displayed on a tab or page indicates that the field is required and
is either missing a value or contains an invalid value.

Note

Step 3

Step 4

Specify the following information to connect to the SAP Solution Manager system:
Field

Description

Display name

Enter a name for the SAP Solution Manager system.
This is the name that will display in the Targets pane.

Organization

Enter the group or organization within the company that
owns the target.

Click Next.

The system information entered on this panel must be unique. Otherwise, an error message
displays informing you that the wizard detected another system already registered with the same
information.

Note

Step 5

Specify the following information to connect to the SAP Solution Manager target:
Field

Description

Connect using

Choose the connection method from the drop-down list.
The fields that display on the panel depend on the
connection method selected.

Application server

Choose this option to connect to the SAP Solution
Manager target using the SAP application server
connection information.
Specify the information in the following fields:
•

Server name—Enter the name of the SAP Solution
Manager application server.

•

System number—Enter the SAP Solution Manager
system number.
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Field

Description

Logon group

Choose this option to establish a connection using a logon
group, which contains a group of SAP Solution Manager
system instances. When a user logs on to a logon group, the
message server directs the users to the server of this group
that currently has the lightest load.
Specify the information in the following fields:

Router string (optional)

•

System ID—Enter the SAP Solution Manager system
ID (SID).

•

Message server—Enter the name of the server a user
logs on to and that handles the communication
between the application servers. For example,
transport of update requests and lock requests.

•

Group name—Enter the name of the Logon Group to
be accessed. The name entered in this field is
case-sensitive.

Enter the router string for accessing the SAP Solution
Manager systems via SAPRouter. If you do not specify a
router string, Process Orchestrator accesses the SAP
Solution Manager system directly.
The router string must be formatted as:
/H/host01/H/host02/H/
where host01 and host02 are the SAP Solution Manager
systems that you want to access through the SAPRouter.

Default runtime user

Step 6

Choose the user account that contains the credentials to
connect to the target from the drop-down list.
•

To view the properties for the selected runtime user,
click the Properties
tool.

•

To create a new SAP User, click New > SAP User. See
the Intelligent Automation for SAP 3.0 Installation
Guide.

Click Next.
The Options panel is used to specify polling intervals and to map the systems that are being monitored
by the Solution Manager target to the SAP System targets configured in Process Orchestrator. The list
box displays the systems that are mapped.

Note

The matching SAP System targets must already be created in Process Orchestrator.
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Step 7

Specify the following information:
Field

Description

Poll Solution Manager alert not older than Specify the value (in minutes, hours or days) to indicate
which SAP Solution Manager alerts to retrieve. Any alerts
older than the specified value will be ignored.
Select a system monitored by Solution
Manager

Choose the SAP system that is monitored by Solution
Manager from the drop-down list.

Select a matching system montored by
Process Orchestrator

Choose the SAP system target that is configured in Process
Orchestrator from the drop-down list. This target must
already be defined in Process Orchestrator.

Add to List

Click this button to add the mapped configuration to the
list of systems to be monitored.

Refresh

Click this button to refresh the list of systems to be
monitored.

Step 8

Click Next.

Step 9

Verify that the information is correct and click Finish to complete the procedure.
The SAP Solution Manager target displays in the Targets pane.

Managing SAP Solution Manager Targets
Use the Definitions—Targets view to manage the SAP Solution Manager targets. From this view, you
can enable and disable the target, delete the target, and view and modify the target properties.

Enabling a Target
A target is enabled by default after it is created. If a target is manually disabled, it must be enabled before
it is available for execution.
Step 1

Step 2

On the Definitions—Targets view, use one of the following methods to enable the target:
•

In the Targets pane, right-click the target and choose Enable.

•

In the Targets pane, select the target and then click the Click here link in the Details pane.

Verify that the status in the Enabled column in the Targets pane is True. If necessary, click the Refresh
tool to update the view.
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Disabling a Target
Disabling a target prevents it from being available for execution. However, a disabled target is not
removed from the list of targets in the Targets pane.
Step 1

Step 2

On the Definitions—Targets view, use one of the following methods to disable the target:
•

In the Targets pane, right-click the target and choose Disable.

•

In the Targets pane, select the target and then click the Click here link in the Details pane.

Verify that the status in the Enabled column in the Targets pane is False. If necessary, click the Refresh
tool to update the view.

Deleting a Target
Before deleting a target, open the SAP Solution Manager Target Properties dialog box and click the Used
By tab to view where objects are being used by the target. This ensures that deleting the target does not
affect any processes or activities.
Step 1

In the Definitions—Targets view, right-click the target and choose Delete.

Step 2

Click Yes to confirm the deletion. The target will be removed from the product.
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Modifying Solution Manager Targets
Use the Definitions—Targets view to display and modify the Solution Manager target properties.

Modifying Display Name and Enabling/Disabling Target
Use the General tab on the Solution Manager Target Properties dialog box to modify the display name
of the target, and to enable or disable the target
Step 1

In the Definitions view, click Targets to display the defined targets in the Targets pane.

Step 2

Double-click the SAP Solution Manager target, or right-click and choose Properties.

Step 3

Use the General tab to view or modify the following information:
Field

Description

Display name

Name of the Solution Manager target.

Type

Display only. Type of target.

Owner

User name of the owner of the target. This is typically
the person who created the target.
Click the Browse

Step 4

tool to change the owner.

Status

Display only. Current status of the target.

Status information

Display only. Information regarding the target status.

Organization

Name of the group within the company that owns the
target.

Description

Text description of the target.

Enabled

Check or uncheck the check box to enable or disable the
target. The check box is checked by default to indicate
the target is enabled.

Click OK to save your changes and close the dialog box.

Modifying Connection Information
You can modify the connection information to the SAP Solution Manager target using the Connection
tab on the Solution Manager Target Properties dialog box.
Step 1

In the Definitions view, click Targets to display the defined targets in the Targets pane.

Step 2

Double-click the SAP Solution Manager target or right-click and choose Properties.

Step 3

On the SAP Solution Manager Target Properties dialog box, click the Connection tab.
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Step 4

Modify any of the following information to connect to the Solution Manager system:
Field

Description

Connect using

Choose the connection method from the drop-down list.
The fields that display on the panel depend on the
connection method selected.

Application server

Choose this option to connect to the SAP Solution
Manager system using the SAP application server
connection information.
Specify the information in the following fields:

Logon group

•

Server name—Enter the name of the SAP
application server.

•

System number—Enter the SAP system number.

Choose this option to establish a connection using a
logon group, which contains a group of SAP Solution
Manager system instances. When a user logs on to a
logon group, the message server directs the users to the
server of this group that currently has the lightest load.
Specify the information in the following fields:

Router string (optional)

•

System ID—Enter the SAP system ID (SID).

•

Message server—Enter the name of the server a
user logs on to and that handles the communication
between the application servers. For example,
transport of update requests and lock requests.

•

Group name—Enter the name of the Logon Group
to be accessed. The name entered in this field is
case-sensitive.

Enter the router string for accessing the SAP Solution
Manager systems via SAPRouter. If you do not specify
a router string, Process Orchestrator accesses the SAP
system directly.
The router string must be formatted as:
/H/host01/H/host02/H/
where host01 and host02 are the SAP systems that you
want to access through the SAPRouter.

Default runtime user

Step 5

Choose the user account that contains the credentials to
connect to the target from the drop-down list.
•

To view the properties for the selected runtime
user, click the Properties
tool.

•

To create a new SAP User, click New > SAP User.
See the Intelligent Automation for SAP 3.0
Installation Guide.

Click OK to save your modifications and close the dialog box.

Process Automation Guide for SAP Solution Manager E2E Response
OL-30858-01

3-9

Chapter 3

Getting Started Using the Automation Pack

Managing SAP Solution Manager Targets

Modifying Polling and Mapping Information
You can modify the interval in which the Solution Manager target is polled for alerts using the Options
tab on the Solution Manager Target Properties dialog box. You can also view the mappings between
systems being monitored by Solution Manager and the SAP systems configured in Process Orchestrator.
You can add or remove systems to be monitored.
Step 1

In the Definitions view, click Targets to display the defined targets in the Targets pane.

Step 2

Double-click the SAP Solution Manager target, or right-click and choose Properties.

Step 3

On the SAP Solution Manager Target Properties dialog box, click the Options tab.

Step 4

Modify any of the following information:
Field

Description

Solution Manager alert polling interval

Enter the number of seconds in the Solution Manager alert
polling interval field that indicates how often the Solution
Manager target should be polled for alerts.
Note

If you change the alert polling interval, you must
restart the Process Orchestrator service before the
changes are implemented.

Poll Solution Manager alert not older than Specify the value (in minutes, hours or days) to indicate
which SAP Solution Manager alerts to retrieve. Any alerts
older than the specified value will be ignored.

Step 5

Select a system monitored by Solution
Manager

Choose the SAP system that is monitored by Solution
Manager from the drop-down list.

Select a matching system montored by
Process Orchestrator

Choose the SAP system target that is configured in Process
Orchestrator from the drop-down list. This target must
already be defined in Process Orchestrator.

Add to List

Click this button to add the mapped configuration to the list
of systems to be monitored.

Refresh

Click this button to refresh the list of systems to be
monitored.

Remove

To remove a system from being monitored, select the name
of the system in the list box and click Remove.

Click OK to close the dialog box.

Viewing Member Of Properties
You can view the target groups to which a target belongs using the Member Of tab on the SAP Solution
Manager Target Properties dialog box.
Step 1

In the Definitions view, click Targets to display the defined targets in the Targets pane.

Step 2

Double-click the SAP Solution Manager target, or right-click and choose Properties.

Step 3

On the SAP Solution Manager Target Properties dialog box, click the Member Of tab.
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Step 4

In the list box, view the target groups that the target is a member.

Step 5

To view the properties of a specific target group, right-click and choose Properties.

Step 6

Click OK to close the dialog box.

Viewing Properties
You can view the list of target properties defined for a specific target type using the Properties tab on the
Solution Manager Target Properties dialog box.
Step 1

In the Definitions view, click Targets to display the defined targets in the Targets pane.

Step 2

Double-click the Solution Manager target, or right-click and choose Properties.

Step 3

On the Solution Manager Target Properties dialog box, click the Properties tab.

Step 4

In the list box, view the target properties that are assigned to the target.

Step 5

To modify a target property, right-click and choose Edit.

Note
Step 6

For additional information on Target Properties, see the Process Orchestrator User Guide.

Click OK to close the dialog box.
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Viewing Used By Properties
You can view the objects that are directly associated with the selected target (for example, an SAP
system or process) using the Used By tab on the SAP Solution Manager Target Properties dialog box.
Step 1

In the Definitions view, click Targets to display the defined targets in the Targets pane.

Step 2

Double-click the SAP Solution Manager target, or right-click and choose Properties.

Step 3

On the SAP Solution Manager Target Properties dialog box, click the Used By tab.

Step 4

View the objects that are used by the target in the list box.

Step 5

To view the properties of a specific object, right-click and choose Properties.

Step 6

Click OK to close the dialog box.
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Viewing Target History
You can view the history of changes that have been made to the target using the History tab on the SAP
Solution Manager Target Properties dialog box.
Step 1

In the Definitions view, click Targets to display the defined targets in the Targets pane.

Step 2

Double-click the SAP Solution Manager target, or right-click and choose Properties.

Step 3

On the SAP Solution Manager Target Properties dialog box, click the History tab.

Step 4

View the changes that have been made to the target.

Step 5

To view the audit history for a specific action in the list box, right-click the item and choose Properties.

Step 6

Click OK to close the dialog box.
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Using Task Rules for Assignments and Notifications
Task rules are used to manage task assignments and notifications for tasks, such as incidents and alerts,
that are generated from processes. When you import the Core Automation for SAP automation pack, you
are prompted to specify the default user or group who should be assigned SAP incidents. By default, this
person will receive all assignments unless task rules are created to specify alternate users or groups for
specific tasks.
This section guides your through configuring the task rule that ships with the Core Automation for SAP
automation pack and provides instructions for creating and managing task rules.

Note

If you do not want to create task rules for email notifications, you can use the default notification based
on assignment processes that ship with the Core automation pack. These processes are disabled by
default and must be enabled if you want notifications to be sent (see Enabling Notification Based on
Assignment Processes, page 3-23).

Accessing Task Rules View
The task rule that ships with the Core Automation for SAP automation pack can be accessed from the
Definitions—Task Rules view.
Step 1

On the Console, select the Definitions workspace and click Task Rules in the navigation pane. By
default, all the rules display in the Task Rules pane.

Step 2

Click the Filter by link and choose Automation Pack > [Automation Pack Name] to filter for only the
task rules that ship with the specific automation pack.
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The following information about the task rules displays by default:
Column

Description

Display Name

The name assigned to the task rule.

Enabled

Indicates whether the task rule is enabled (True) or
disabled (False). A disabled task rule is unavailable for
execution.

Type

Type of task.

Owner

User name of the person or group who assigned the task
rule.

Last Modified Time

The date and time the task rule was last modified.

Last Modified By

The object or user name that last modified the task rule.

Id

Unique ID of the task rule.

Description

Brief description of the task rule.

Type Description

Brief overview of the task rule type.

Created Time

Time at which the task rule was created.

Created Date

Date the task rule was created.

Automation Pack

Name of the automation pack associated with the task rule.

Configuring Task Rules
Use the Task Rules view to configure the task rule that ships with the Core Automation for SAP
automation pack.

SAP Default Assignment
The Core Automation for SAP automation pack ships with the Default SAP Assignment task rule, which
is used to specify the default user or group who will be assigned all SAP-related incidents unless
otherwise specified in task rules. This task rule can be configured during the import process on the
Default Incidents Assignee Setup panel or from the Task Rules view in the Console.
Step 1

In the Definitions workspace, click Task Rules in the navigation pane to display the task rules in the
results pane.

Step 2

Click the Filter by link and choose Automation Pack, and then choose Core Automation for SAP from
the drop-down list to display the task rules that ship with the automation pack.

Step 3

Right-click the SAP Default Assignment task rule and choose Properties to open the SAP Default
Assignment Properties dialog box.

Step 4

Click the Assign tab to specify the user or group that should receive assignments for incidents and alerts
generated by the processes.

Step 5

On the Assign tab, click Add to open the Select Assignee to Add dialog box.

Step 6

On the Select Assignee to Add dialog box, specify the assignees using one of the following methods:
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•

Click the Reference
tool to select the appropriate variable reference containing the assignee or
list of assignees from the Insert Variable Reference dialog box.

•

Click the Browse
assignees.

tool to launch the Select User or Group dialog box to add user to the list of

Step 7

Click OK to add the assignee to the task rule.

Step 8

When you have completed adding assignees to the task rule, click OK to close the dialog box.
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Creating a New Task Rule
Use the Task Rules view to create a new task rule. The procedure is the same for all types of task rules
with the exception of the task-specific tab (Assign, Notify, Update) for the type of task rule you are
creating.

Note

Only users with administrative rights can create task rules in Process Orchestrator.
You can create the following types of task rules:
Task Rules

Description

Assign Task Rule

Assigns users to a task.

Notify Task Rule

Notifies users that a task has been created.

Update Task Rule

Specifies the properties to be updated in a task.

Step 1

In the Definitions workspace, right-click Task Rules and choose New > [Task Rule Type] to open the
New Rule Properties dialog box.

Step 2

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task.

Type

Display only. Shows the type of object.

Trigger

Display only. Type of trigger associated with the task rule.

Owner

User name of the owner of the task rule. This is typically
the person who created the task rule.
Click the Browse
tool to launch the Select User or
Group dialog box to change the owner.

Description

A brief description of the task rule.

Enabled

The check box is checked by default to indicate that the
task rule is available for execution.
Uncheck the check box to disable the task rule. If the
check box is unchecked, the task rule is disabled and will
be unavailable for execution.

Step 3

Click the Task Types tab to specify the types of tasks to be executed by the rule.

Step 4

Check the check box for the type of task that will execute the rule.
Task Type

Description

Alert

Alerts reflect potential problems that a user may want
to investigate and possibly diagnose the problem.

Approval Request

Specifies the message and choices for the assignee who
is approving the task.

Guided Operation

Details the steps a user takes to complete an assigned
task.
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Step 5

Task Type

Description

Incident

Task requires an operator to take action in order to
resolve an issue.

Input Request

Task requires input from an individual or group.

Review

Task assigns a document for review.

Click the Conditions tab to specify the conditions of when the task rule action is to be taken based on
an evaluation of the defined conditions.

The Required Value
icon displayed on a tab or page indicates that the field is required and
is either missing a value or contains an invalid value.

Note

Step 6

On the Conditions tab, define the conditions that must be met for the rule to execute.
Defining a Basic Condition:
a.

On the Basic page, click New to add a new property for the condition that must be met.

b.

In the Property text field, click the Reference
tool to choose a defined variable or reference an
object on the Insert Variable Reference dialog box.

c.

Choose the condition expression from the drop-down list.

d.

Enter the condition description in the text box or click the Reference
tool to choose a defined
variable or reference an object on the Insert Variable Reference dialog box.

e.

Click New to define additional properties, if necessary.

Defining an Advanced Condition:
a.

Click the Advanced tab to define a specific type of condition (Compound, Prior Process Instance,
Time, or Variable).

b.

Click the link to modify the option for the condition equation.

Option

Description

AND condition (all conditions must be met) Click this option if an action is to be taken only when
all conditions in the list are true.
OR condition (one condition must be met)

c.

Click New and choose the type of condition from the drop-down list.

d.

Specify the relevant information for the type of condition selected.

Note

e.
Step 7

Click this option if an action is to be taken when one
condition in the list is true.

Click the Reference
tool to choose a defined variable or reference an object on the Insert
Variable Reference dialog box.

Click New to define additional properties, if necessary.

Click the task rule specific tab (Assign, Notify, or Update) and specify the relevant information for the
specific type of rule.
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Assign Task Rule

If you are creating an Assign Task Rule, the Assign tab displays on the New Rule Properties dialog box.
On the Assign tab, specify the assignees for task rule.
Field

Description

Add

Click this button to launch the Select Assignee to Add
dialog box to specify the assignees.
On the Select Assignee to Add dialog box, use one of the
following methods to specify the assignee:
•

Click the Reference
tool to select the appropriate
variable reference containing the assignee or list of
assignees from the Insert Variable Reference dialog
box.

•

Click the Browse
tool to launch the Select User or
Group dialog box and add user to the list of assignees.

Edit

Select the appropriate assignee in the list and click this
button to view or modify the assignee of the task rule.

Remove

Select the appropriate assignee and click this button to
remove the assignee from the list.

Remove All

Click this button to remove all specified assignees from the
list.
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Notify Task Rule

If you are creating a Notify Task Rule, the Notify tab displays on the New Rule Properties dialog box.
On the Notify tab, specify the recipients of the notification that the task rule has executed. You can add
individual recipients or include a notification recipient list.
Field

Description

Add notification recipients

Displays list of users to be notified by the task rule.
•

Add—Click this button to launch the Select
Notification Recipient to Add dialog box to specify
the recipients.
On the dialog box, enter the email address for the
recipient or click the Reference
tool to select
the appropriate variable reference containing the
recipient or list of recipients from the Insert
Variable Reference dialog box and then click OK.

Add notification recipient list

•

Edit—Select the appropriate recipient in the list
and click this button to view or modify the recipient
of the task rule.

•

Remove—Select the appropriate recipient in the list
and click this button to remove the recipient from
the list.

•

Remove All—Click this button to remove all
specified recipients from the list.

Click the Reference
tool to select the appropriate
variable reference containing list of recipients from the
Insert Variable Reference dialog box.

Update Task Rule

If you are creating an Update Task Rule, the Update tab displays on the New Rule Properties dialog box.
On the Update tab, specify the properties to be updated after the task rule has executed.
Field

Description

Add

Click this button to add a new property to the Properties to
update area.

Remove

Click this button to remove the last property added to the
Properties to update area.

Property

From the Property drop-down list, choose the item to
update within the task. The properties displayed depend on
the selected item.

List action

Choose the appropriate item from the drop-down list to
determine which action to take with the selected property:

Value

•

Add Item—Adds item to task.

•

Remove item—Removes item from task.

•

Clear—Removes property value from task.

Enter new value for the property.
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Step 8

Click OK to save the task rule definition and close the dialog box.

Managing Task Rule Definitions
This section provides instructions on modifying task rules in the Definitions—Task Rule view. Only
users with administrative rights can modify task rules in Process Orchestrator.

Note

For additional information on managing task rules, see the Process Orchestrator User Guide.

Enabling a Task Rule
A task rule is enabled by default. If a task rule is manually disabled, the task rule must be enabled before
it is available for execution.
On the Definitions—Task Rules view, select the task rule and then use one of the following methods to
enable it:
•

On the Results pane, right-click and choose Enable.
-or-

•

On the Details pane, select Click here to enable.

The Enabled column on the Results pane changes to True. If necessary, click the Refresh
update the view.

tool to

Disabling a Task Rule
Disabling a task rule prevents the item from being available for execution. The disabled task rule is not
removed from the list of task rules on the Definitions—Task Rules Results pane.
On the Definitions—Task Rule view, select the task rule and then use one of the following methods to
disable it:
•

On the Results pane, right-click and choose Disable.
-or-

•

On the Details pane, select Click here to disable.

The Enabled column on the results pane changes to False. If necessary, click the Refresh
update the view.

tool to
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Creating a Copy of a Task Rule
The copy option is used when the user wants to leverage an existing task rule to define a new task rule
using existing properties.
Step 1

On the Definitions—Task Rules view, select the appropriate task rule, right-click and choose Copy.

Step 2

On the Results pane, right-click and choose Paste.
A copy of the defined task rule is pasted onto the Results pane.

Step 3

To rename the copied task rule or other properties, right-click and choose Properties.

Step 4

Modify the task rule name, as appropriate, and click OK to close the dialog box.

Sorting Task Rules
The task rules are executed according to the order they are listed on the Definitions—Task Rules view.
You should sort the task rules based on the order in which you want them to execute.

Note

All task rules will execute even if there is more than one task rule assigned for the same condition. For
example, if you have two assignment rules for the same incident, both rules will be executed in the order
listed in the Task Rules view.

On the Definitions—Task Rules view, select the task rule and use one of the following methods to move
it to the desired position in the list:
•

Drag and drop the task rule into the appropriate position in the list.

•

On the Actions toolbar, click Move Up or Move Down.

•

Click the Actions menu and choose Move Up or Move Down.

•

Right-click and choose Move Up or Move Down.

The list of task rules are sorted according to the selected action.

Deleting a Task Rule
Use the Definitions—Task Rules view to delete task rules that are no longer used.
Step 1

On the Definitions—Task Rules view, select the task rule, right-click and choose Delete.

Step 2

On the Confirm Delete dialog box, click Yes to confirm the deletion.
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Enabling Notification Based on Assignment Processes
If you want to have emails sent to whoever is assigned to a task but do not want to create notification
task rules, you can enable the processes that ship with the Core automation pack that send emails based
on assignment.
When these processes are enabled, the user or user group who was assigned to tasks will receive the
email notification.
Step 1

In the Definitions workspace, click Processes.

Step 2

Click the Filter by link and choose Automation Pack > Core to filter for the processes that ship with
the Core automation pack.

Step 3

Right-click the appropriate Notification Based on Assignment process and choose Enable.
The following processes are for notification based on assignment:
Process Name

Description

Default Alert Notification Based on
Assignment

Sends email when an alert gets assigned.

Default Approval Request Notification
Based on Assignment

Sends email when an approval request gets assigned.

Default Change Request Notification Based
on Assignment

Sends email when an change requests gets assigned.

Default Guided Operation Request
Notification Based on Assignment

Sends email when a guide operation request gets
assigned.

Default Incident Notification Based on
Assignment

Sends email when an incident gets assigned.

Default Input Request Notification Based on Sends email when an input request gets assigned.
Assignment
Default Review Request Notification Based
on Assignment

Send email when a review request gets assigned.
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Managing Target Properties
The SAP Solution Manager E2E Response processes use target properties to override certain variable
properties assigned to targets. For example, target properties can be used to specify a different target
when certain conditions occur.
This section provides information on configuring target properties.

Accessing Target Properties
The target properties that ship with the SAP Solution Manager E2E Response automation pack can be
accessed from the Definitions—Target Properties view.
Step 1

On the Console, select the Definitions workspace and click Target Properties in the navigation pane.
By default, all the properties display in the Target Properties pane.
The following information about the target properties displays by default:

Step 2

Column

Description

Display Name

Name of the target property.

Description

Text description of the target property.

Value

Value assigned to the target property.

Data Type

Type of value being used for the target property (Boolean,
Encrypted String, Identity, Numeric, String, Table).

Automation Pack

Name of the automation pack that provides the target
property.

Customizable

Indicates the customization setting for the target property
in the automation pack.

Target Types

Indicates the targets associated with the target property.

Last Modified Time

Date and time the variable was last modified.

Last Modified By

Name of the user who last modified the target property.

Id

Unique ID of the target property.

Owner

User name of the owner of the target property. This is
typically the person who created the target property.

Created Time

Date and time the target property was created.

Created By

User name of the person who created the target property.

Click the Filter by link and choose Automation Pack > SAP Solution Manager E2E Response to filter
for only the target properties that ship with the specific automation pack.

Configuring Target Properties
You use the Target Properties Properties dialog box to view or modify the target property. You access
the properties from the Definitions—Target Properties view.
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Note

If the Target Properties view is hidden, go to Tools > Options. On the Options dialog box, click the
Windows and Layout tab and select the Display target properties definitions node check box.
The following section provides information on configuring target properties that ship with the SAP
Solution Manager E2E Response automation pack.

Step 1

On the Target Properties pane, right-click [Target Property] and choose Properties.

Step 2

On the General tab, review the information in the Description field to determine the values that need to
be specified for the target property.

Step 3

Click the Value tab to view or modify the default value for all targets.

Note

The tab in the second position will depend on the variable type. See the Process Orchestrator
User Guide for instructions on configuring the different types of target properties.

Step 4

Click in the cell to specify the default value or change the default value for all targets.

Step 5

If you want to specify different values to be used on specific targets, click the Target Values tab to
specify the values to override the default values and the targets on which to use the overrides.

Step 6

Click New to add a new target override.

Step 7

On the Target Property Value dialog box, click one of the following radio buttons to indicate which
target(s) will use the override value:
•

Set the value for a single target—Click this radio button to specify only one target that will use the
override value.

•

Set the same value for multiple targets—Click this radio button to specify multiple targets that will
use the override value.

Step 8

Click the Browse

icon to open the Select Target dialog box.

Step 9

Select the target in the list and click OK.

Step 10

In the Value area, click in the cell to specify the override values to be used for the specified targets and
click OK.
The target override displays on the Target Values tab.

Step 11

Click OK to close the dialog box and save your changes.

Note

The Target Types tab is only available if you have explicit rights to the object. See the Process
Orchestrator User Guide for information on using this property page.
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Managing Global Variables
The processes use global variables for information that is used on a regular basis to avoid having to
specify the same information in several processes or activities. Some of the variables that ship with the
automation packs are configured with default values but can be modified to meet the requirements for
your specific environment. Other variables do not have default values defined and must be defined by
the user before it can be used in the processes.
The Core Automation for SAP automation pack ships with the global variables that must be configured
before they can be used in the processes.

Accessing Global Variables
The global variables that ship with the Core Automation for SAP automation pack can be accessed from
the Definitions—Global Variables view.
Step 1

On the Console, select the Definitions workspace and click Global Variables in the navigation pane. By
default, all the variables display in the Global Variables pane.

Step 2

Click the Filter by link and choose Automation Pack > Core Automation for SAP to filter for only
the global variables that ship with the specific automation pack.
The following information about the variables displays by default:
Column

Description

Display Name

Name of the global variable.

Description

Brief overview of the global variable.

Value

Value of the variable.

Data Type

Type of value being used for the variable (Boolean,
Encrypted String, Identity, Numeric, String, Table).

Automation Pack

Name of the automation pack that provides the object.

Last Modified Time

Time the global variable was last modified.

Last Modified By

Name of the user who last modified the global variable.

Configuring Global Variables
SAP Alert Suppression Time Properties
The SAP Alert Suppression Time global variable contains the length of time (in seconds) that SAP alerts
will be suppressed when duplicated. After this time, a new alert and incident will be created.
Step 1

In the Definitions view, click Global Variables in the navigation pane to display the variables in the
Global Variables pane.
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Step 2

Click the Filter by link and choose Automation Pack > Core Automation for SAP to filter for only
the global variables that ship with the Core Automation for SAP automation pack.

Step 3

In the Global Variables pane, right-click the SAP Alert Suppression Time global variable and choose
Properties.

Step 4

In the Value text field, enter the number of seconds to suppress duplicate alerts and click OK.
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Managing SAP Solution Manager E2E Response
Processes
This chapter provides information on using the product, specific to the SAP Solution Manager E2E
Response automation pack. It includes information on accessing the SAP Solution Manager E2E
Response processes and filtering for specific processes, managing the SAP processes, starting a process,
and viewing a running process, its results, and the automation summary generated by the process.
It includes the following sections:

Note

•

Accessing SAP Solution Manager E2E Response Processes, page 4-2

•

Managing SAP Solution Manager Processes, page 4-3

•

Running Processes, page 4-8

•

Viewing Process Results, page 4-9

•

Viewing Automation Summary, page 4-11

Before you can run the SAP Solution Manager E2E Response processes, you must configure the objects
that are referenced by the processes and activities. See Chapter 3, “Getting Started Using the Automation
Pack” for information on configuring the SAP-related objects in Process Orchestrator.
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Accessing SAP Solution Manager E2E Response Processes
The processes that ship with the product can be accessed from the Definitions—Processes view.
Step 1

On the Console, select the Definitions workspace and click Processes in the navigation pane. By default,
all the processes display in the Processes pane.
If you have multiple automation packs installed, you can filter the processes to display the processes
specific to the automation pack.

Step 2

In the upper portion of the Processes pane, click the Filter by link and choose Automation Pack.

Step 3

In the drop-down list, choose SAP Solution Manager E2E Response.
The processes display in the Processes pane.
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Managing SAP Solution Manager Processes
This section provides information on managing the SAP Solution Manager processes, including:
•

Enabling and disabling processes

•

Enabling and disabling the process archival feature

•

Creating a Solution Manager Alert Trigger

Enabling a Process
Some of the processes that ship with the automation packs are disabled by default to reduce the load on
the server. These processes must be enabled before they can execute.
Perform the following steps to enable a process.
Step 1

In the Processes view, navigate to the process that you want to enable (disabled processes appear
dimmed).

Step 2

Use one of the following methods to enable the process:
•

Right-click the process and choose Enable from the submenu.

•

In the Process Editor, click the General tab and then check the Enabled check box. Click the Save
tool to save your changes to the process and close the Process Editor.

Disabling a Process
Disabling a process prevents the process from executing. You may want to disable some processes to
reduce the load on your server or while you are modifying the process definition.
Perform the following steps to disable a process.
Step 1

In the Processes view, navigate to the process that you want to disable.

Step 2

Use one of the following methods to disable the process:
•

Right-click the process and choose Disable from the submenu.

•

In the Process Editor, click the General tab and then uncheck the Enabled check box. Click the
Save
tool to save your changes to the process and close the Process Editor.
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Modifying Process Instance Archival
Process Orchestrator provides an option in the process definition that allows you to choose whether or
not to archive process and activity execution in the Process Orchestrator Process database. Disabling the
Archive completed instances option helps improve performance and minimize the size of the database.
It is also useful when debugging the execution of processes.
The automation packs shipped by Cisco normally have the archival functionality disabled by default for
the SAP Solution Manager E2E Response processes. If you want to view the execution of a process and
its activities, or view the process instances after a process has completed, you must enable the archival
functionality in the process definition.
Perform the following steps to enable or disable the archival feature.
Step 1

In the Processes view, navigate to the process you want to flag for archival.

Step 2

Right-click the process and choose Edit from the submenu.

Step 3

On the process Properties dialog box, click the Options tab.

Step 4

On the Options tab, click one of the following radio buttons to indicate how you want to archive the
process instance.
Field

Description

Never archive any instances

Click this radio button to indicate that the process should
not be stored upon completion.

Only archive failed instances

Click this radio button to indicate that only failed instances
should be archived.

Archive all completed instances

Click this radio button to indicate that the process should
be stored upon completion.

Archive based on condition

Click this radio button to indicate that the process should
be stored based on the condition (True/False) selected.
Click the Browse
tool to launch the Archive Condition
dialog box and select the condition.

Creating a Solution Manager Alert Trigger
Use the Solution Manager Alert trigger to specify the properties in the monitoring tree element (MTE)
that must be matched before an alert is generated. When the specified alert is generated, the process is
executed.
Step 1

On the Definitions—Processes view, use one of the following methods to open the Process Editor:
•

Select an existing process, right-click and choose Edit.

•

Right-click Processes in the navigation pane and choose New > Process.

Step 2

On the Process Editor properties, click the Triggers tab.

Step 3

On the Triggers tab, click New > Solution Manager Alert.
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Step 4

On the General tab, enter the following general information about the trigger:
Field

Description

Display name

Name of the trigger that displays in the Processes pane.

Type

Display only. Type of trigger.

Description

Text description of the trigger.

Enabled

Check or uncheck the check box to enable or disable the
trigger. The check box is checked by default.
If you uncheck the check box, the trigger is disabled
and will be unavailable.

Step 5

Click the Alert tab to specify the alert criteria.

Step 6

On the Alert tab, check the check box for the criteria to match and then specify the relevant information:
Field

Description

Category

Specify the category in Solution Manager to be matched.

Managed object name

Specify the managed object name in Solution Manager to
be matched.

Managed object type

Specify the managed object type in Solution Manager to be
matched.

System Id

Specify the SAP system ID for the system that generated
the alert.

Alert name

Specify the name of the alert in Solution Manager.

Alert technical name

Specify the technical name of the alert in Solution
Manager.

Description

Specify a text description of the alert.

Alert Rating

Check the check box next to the severity level of the alerts
to be monitored:

Note

Red

•

Yellow

•

Green

•

Unknown

Click the Reference
tool to choose a defined variable or reference an object on the Insert
Variable Reference dialog box.
Click the Insert Wildcard

Step 7

•

tool to choose a wildcard.

Click the Targets tab.
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Step 8

On the Targets tab, specify the target on which to monitor for alerts that will trigger the process:
Field

Description

Monitor on this target

Click this radio button and then click the Browse
tool
to launch the Select Targets dialog box and select a specific
target to be monitored for the fault.
To view the properties for the target, click the Properties
tool.

Choose a target reference

Click this radio button and then click the Reference
tool to choose a target reference property.
You can also click the Browse
tool to launch the Select
Target Group dialog box and select a specific target to be
monitored for the alert.

Monitor on this target group

Click this radio button and then click the Browse
tool
to launch the Select Target Group dialog box and select a
specific target group to be monitored for the alert.
To view the properties for the target group, click the
Properties
tool.
If this option is selected, you must also specify which
targets to monitor for events:
•

All targets in this group—Click this radio button to
monitor events on all targets in the target group.

•

Choose a target using this algorithm—Click this radio
button to choose a target from the eligible target group
members and specify the criteria to be met.

Step 9

Click the Conditions tab.

Step 10

On the Conditions tab, specify the conditions when the trigger should execute based on an evaluation of
the defined conditions.
Defining a Basic Condition:
a.

On the Basic page, click New to add a new property for the condition that must be met.

b.

In the Property text field, click the Reference
tool to choose a defined variable or reference an
object on the Insert Variable Reference dialog box.

c.

Choose the condition expression from the drop-down list.

d.

Enter the condition description in the text box or click the Reference
tool to choose a defined
variable or reference an object on the Insert Variable Reference dialog box.

e.

Click New to define additional properties, if necessary.

Defining an Advanced Condition:
a.

Click the Advanced tab to define a specific type of condition (Compound, Prior Process Instance,
Time, or Variable).

b.

Click the AND/OR link to modify the option for the condition equation.

c.

Click New and choose the type of condition from the drop-down list.

d.

Specify the relevant information for the type of condition selected.
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Click the Reference
tool to choose a defined variable or reference an object on the Insert
Variable Reference dialog box.
e.

Note
Step 11

Click New to define additional properties, if necessary.

For additional information on creating Conditions, see the Process Orchestrator User Guide.

Click OK to complete the trigger definition and close the dialog box.
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Running Processes
The processes that ship with the product will run based on the trigger that was defined in the process
definition. For processes that are triggered by a schedule, you can also manually start a process at any
time (adhoc). This section guides you through starting a process and viewing its progress as it runs.

Note

You can only view a running process and the process instances for processes that have the Archive
completed instances feature enabled. See Modifying Process Instance Archival, page 4-4 for information
on enabling the archival feature on a specific process.

Starting a Process
Step 1

In the Processes view, right-click the process and choose Start Process from the submenu.
The Confirm Start Process dialog box displays.

Step 2

On the Confirm Start Process dialog box, click the Target or Target Group radio button and then click
the Browse
tool to open the Select Target dialog box.

Step 3

Select the target in the list and then click OK.

Step 4

On the Confirm Start Process dialog box, click OK to start the process.
The Start Process Results dialog box displays. Proceed to Viewing Running Process, page 4-9.
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Viewing Running Process
After starting the process, you can use the Process Viewer to view the process as it runs through each
activity.

Note

Step 1

You can only view a running process and the process instances for processes that have the Archive
completed instances feature enabled. See Modifying Process Instance Archival, page 4-4 for information
on enabling the archival feature on a specific process.
On the Start Process Results dialog box, right-click the process and choose Observe.
The Process Viewer displays the process workflow.

Step 2

View the process as it proceeds through the workflow.
The activities within the process workflow will change to green as they complete (succeed). If an activity
fails, an incident is created.

Step 3

When the process completes, close the Process Viewer and proceed to Viewing Process Results,
page 4-9.

Viewing Process Results
After a process completes, you can view the results in the Operations workspace. This section guides
you through viewing the results from running the process.

Note

You can only view a running process and the process instances for processes that have the Archive
completed instances feature enabled. See Modifying Process Instance Archival, page 4-4 for information
on enabling the archival feature on a specific process.

Accessing Process View
Step 1

On the Operations workspace, expand Process Views in the navigation pane and click View Adhoc
(since the process was manually executed).

Step 2

Using the Filter by link, choose Automation Pack and then choose SAP Solution Manager E2E
Response from the drop-down list.

Step 3

Scroll to the process and select it.

Step 4

In the View Results pane, expand the process to view each activity in the process workflow.

Step 5

Review the status of the process and each activity within the process to verify that it has succeeded.
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Viewing Activity Results
You can view the results of a specific activity within the process using the Activity Instance Properties
dialog box.
Step 1

In the View Results pane, scroll to an activity.

Step 2

Right-click [process activity] and choose Properties.

Step 3

Click the appropriate tab to view the results. The tab that displays depends on the activity.

Step 4

When you have completed reviewing the results, click Close to close the dialog box.

Viewing Incidents
When a process detects an issue that requires action, an incident is generated. If you have configured the
product to send notifications to a specific person in your organization, that person will receive an email
notification whenever an incident is generated. You can also view these incidents in the Task Views on
the Operations workspace.
Step 1

On the Operations workspace, expand Task Views in the navigation pane and click View Incidents.

Step 2

In the View Incidents pane, choose View all tasks from the Task Assignee drop-down list to display all
the incidents in the View Results pane.

Step 3

To view a specific incident, right-click the incident and choose Open.
The Incident Report displays in your web browser.

Process Automation Guide for SAP Solution Manager E2E Response

4-10

OL-30858-01

Chapter 4

Managing SAP Solution Manager E2E Response Processes
Viewing Automation Summary

Viewing Automation Summary
When incidents are generated, Process Orchestrator delivers an online Automation Summary that details
the analysis that was performed to identify a situation that may require action. It also shows relevant
diagnostic and state information captured while performing the situation analysis, and provides a
recommended resolution for the situation.
You can access the Automation Summary from the Tasks View on the Operations workspace.
Step 1

On the Operations workspace, expand Task Views in the navigation pane and click View Incidents.

Step 2

In the View Incidents pane, click the View all tasks radio button to display the incidents in the View
Results pane.

Step 3

Right-click [Incident Name] and choose View Automation Summary.
The Automation Summary displays in your web browser.
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A

Understanding the Core Automation for SAP
Content
The Cisco Process Orchestrator Automation Pack for Core Automation for SAP contains content that is
used in the other SAP-related automation packs.
This appendix contains the content included in the Core Automation for SAP automation pack. It
contains the following sections:
•

Automation Pack Content, page A-1

•

Automation Pack Dependencies, page A-4

Automation Pack Content
Use the automation pack Properties dialog box to view the content (objects) included in the automation
pack. For instructions on accessing the automation pack properties, see Accessing Automation Pack
Properties, page 2-2.

Core Automation for SAP Task Rules
The following table contains the task rule that is imported by the Core Automation for SAP automation
pack.
Task Rule

Description

SAP Default Assignment

Default user or group who will be assigned all SAP-related
incidents.

For information on configuring Task Rules, see Using Task Rules for Assignments and Notifications,
page 3-14.
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Automation Pack Content

Core Automation for SAP Global Variables
The following table contains the global variables that are imported by the Core Automation for SAP
automation pack.
Global Variable Name

Description

SAP Alert Suppression Time

Used to specify the time Process Orchestrator SAP
alerts will be suppressed when duplicated. After this
time, a new alert and incident will be created. Enter the
time in seconds.

Transaction Analyzer Report Location

If you have Cisco Transaction Analyzer installed, you
use this URL to access Transaction Analyzer reports
folder.

For instructions on configuring global variables, see Managing Target Properties, page 3-24.

Core Automation for SAP Processes
The Core Automation for SAP automation pack contains support processes that may be triggered by
alerts and incidents from processes in the other SAP automation packs. You must enable the processes
that will be used in your environment before the other processes can be successfully executed.
For instructions on enabling processes, see Chapter 4, “Managing SAP Solution Manager E2E Response
Processes.”
The following table contains the processes that are imported by the Core Automation for SAP
automation pack.
Process Name

Description

Disable SAP System Monitoring

Allows users to disable the SAP system in Process
Orchestrator. This process can be used as an example to
create custom processes to disable/enable SAP system
monitoring during scheduled downtime.

Enable SAP System Monitoring

Allows users to enable the SAP system in Process
Orchestrator. This process can be used as an example to
create custom processes to disable/enable SAP system
monitoring during scheduled downtime.

Example – Transaction Analyzer Link

Example process for linking to Transaction Analyzer.

Publish SAP Alerts on Windows Event Log

Alerts created by processes in the Automation for SAP
BW and BWA automation pack will create events in the
Windows event log in the Process Orchestrator server.
This is necessary for integration with management
frameworks such as Microsoft SCOM 2007 and HP
OpenView for Windows.
Note

Reset SAP System Alerts and Incidents

This process must be enabled if you have
integrated Process Orchestrator with SCOM
2007 or HP OpenView.

Closes all the alerts and incidents for the selected SAP
system in Process Orchestrator.
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Process Name

Description

SAP Adapter Connection Issue

Monitors the health of Process Orchestrator connection
to SAP systems.

SAP Process Execution Error

Raises an incident when there are errors in activities
executed in SAP processes.

Core Automation for SAP Target Groups
The Core Automation for SAP automation pack provides the target groups that are used by the SAP
processes. Most of the target groups are automatically populated with members when the targets are
configured. For those that are not automatically populated, you must manually add the members. For
information on adding members to target groups, see the Process Orchestrator User Guide.
The following table contains the target groups that are imported by the Core Automation for SAP
automation pack.

Target Group Name

Description

Automatically
Populated with
Members

All Cisco UCS Managers
(SAP)

All UCS Managers.

Yes

All SAP ABAP

All SAP systems configured with component ABAP. Yes

All SAP ABAP 46C

All SAP systems configured with component ABAP
and version 46C.

Yes

All SAP ABAP non 46C

All SAP systems configured with component ABAP
and not version 46C.

Yes

All SAP BI Warehouse

All SAP BI Warehouse targets.

Yes

All SAP Java

All SAP systems configured with component Java.

Yes

All SAP Systems

All SAP systems.

Yes

All SAP Systems – DB2
Mainframe

All SAP systems configured with database DB2
Mainframe.

Yes

All SAP Systems – DB2 UDB All SAP systems configured with database DB2
UDB.

Yes

All SAP Systems – Oracle

All SAP systems configured with database Oracle.

Yes

All SAP Systems – SQL
Server Database

All SAP systems configured with database SQL
Server.

Yes

All Unix Servers (SAP)

All Unix servers.

Yes

All Windows Computers
(SAP)

All Windows server.

Yes

Location Availability
Monitors

Windows computers that have Availability Monitor No
Utility installed. Availability Monitor is used to
monitor location availability. Contact Cisco Systems
support to download the utility.
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Core Automation for SAP Categories
The Core Automation for SAP automation pack ships with categories that are used by the SAP processes.
The following categories are imported by the Core Automation for SAP automation pack.
•

SAP

•

SAP Database SAP DB

•

SAP APO

•

SAP Infrastructure ABAP

•

SAP Application Layer

•

SAP Infrastructure J2EE

•

SAP Availability

•

SAP Operating System

•

SAP Background Processing

•

SAP Performance Metrics

•

SAP BW

•

SAP PI

•

SAP Communication

•

SAP Spool System

•

SAP Configuration

•

SAP System Errors

•

SAP Database DB2

•

SAP Update

•

SAP Database DB2 Mainframe

•

SAP Examples

•

SAP Database Informix

•

SAP Operations

•

SAP Database MS SQL Server

•

SAP Self Monitoring

•

SAP Database Oracle

Automation Pack Dependencies
Use the Dependencies tab on the automation pack Properties dialog box to view the automation packs
and adapters referenced by the objects in the automation pack. These objects must be installed prior to
importing the Core Automation for SAP automation pack.
For instructions on accessing the automation pack properties, see Accessing Automation Pack
Properties, page 2-2.
Object Type

Dependency

Automation Packs

•

Core

Adapters

•

Core Functions Adapter

•

Microsoft Windows Adapter
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